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31) M| QUMTSSILIMISEM6T AHWIDSHSHED, 666leuTeoTNID 5 (pewm Luihd aFiweyD:
1. Whatever you are, be a good one.
2. Be the change you wish to see in the world.
3. Try and fail, but never fail to try.
4. Choose death rather than dishonor.
5. Believe you can and you’re halfway through.
6. A false friend is worse than a bitter enemy.
7. To travel is to take a journey into yourself.
8. I haven’t been everywhere, but it’s on my favorite list.
9. Brief words are best on burning matters.
10. June has put a spirit of youth in everything.
11. Lie down and listen to the crabgrass grow.
12. The earth laughs in flowers.
® 13.  Water is the most precious force of all nature. ®
14. Human beings, must go back to nature for information.

15. Music should strike fire from the heart of human.

2181) Geus LWINHF GFLIWLIEYD:
1. Hear twice before you speak once.
2. True friendship is a plant of slow growth.
3. I never think of the future it comes soon enough.
4. Hasty resolution seldom speeds well.
5. A poem begins in delight and ends in wisdom.
6. Fear of God is the beginning of wisdom.
7. Long ago I bought a dry gold necklace.
8. Krishna got 2/5 and Varsha 3/5 of their shares.
9. Received 5 sets Table(2’6”) & Chairs (1°6”).

10. Pack my box with five dozen juice mugs.
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(2p2) (Amy) LSHBEWET WHE! (PEOD GEUCIGUTETMID

1.

Tracy looked at the flag. The flag is red, white, and blue. It has fifty white stars, seven
red stripes, and six white stripes.

Donald plays the piano. He loves the piano. He has a big piano in his living room.
His piano is shiny and black. It has three legs and a bench.

This weekend I went to the zoo. It was great. I went with my mom and dad. My sister
came, too. The zoo was in the city. The zoo was very long.

When I was playing today at recess, I felt like a kite blown around by the wind. It
was hard to stay in one place because the wind was so strong.

My teacher is awesome. I think she deserves an award for teaching. I have liked all
my teachers, but she is by far the best I've ever had.

(88) (aup&HsLomneT) USHeml Db (PewD SHLLEFS QSIS LLP&HED: (66)616UT60T6MDLD)

1.

Indiaisa DEMOCRATICSOCIALIST country in the World. Infect, DEMOCRATIC
SOCIALISM has been offered as a solution to the DEVELOPMENTAL
resolution which India has undertakes to break through the barrier of UNDER-
DEVELOPMENT of carrying forward the liberation of many millions of people
and pushing through the DEVELOPMENT in all spheres of life. The SOCIALIST
transformation which India aspires is that of building an independent, economy
and comprehensive, including agriculture, on a modern technical basis as early
as possible.

“India is my Country. All INDIANS are my Brothers & Sisters. I love my
country and I am proud of its rich and varied heritage. I shall always strive
to be worth of it.

I shall give respect my parents, teachers and all elders and treat everyone

with courtesy. To my Country and My People, I pledge my Devotion. In their
well-being and prosperity alone lies my happiness”.

The question here is, are all of them entrepreneurs? The answer is both yes and
no. If we say that an entrepreneur is a person, then all the above individuals are
entrepreneurs. When we add that a person having his own business only is an
entrepreneur, excepting Kamath and Prabhudeva, all the others are persons having
their own business — small, very small, or large. But we say that an entrepreneur is a
person who starts his own business. Chandrasekaran and Narayanan are taking care
of the business started by their father; so they are not entrepreneurs. Ramu, whose
mother prepares sundal and asks him to go to beach, sell and bring the money and
give it to her, is also not an entrepreneur, but only an employee. Also, if shops and
businesses are not started by them, then they also cannot be called entrepreneurs.
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FLLES uinmd — una Il

1. GausliLwind — S euELD L chenTem LSl enenthg AL SHed S LG8 aFilg)

(P19 HSHEYLD.

a1) The present constitution of India was framed by the Constitution Assembly of India set

up under the Cabinet Mission Plan of May16, 1946. The idea of establishing a Constituent
Assembly to draw up the Indian Constitution was not a new one. The American Constitution
was framed by a Constitution Assembly. In fact, American Constitution has proved to be
a model to the democratic world. Till independence, India was governed under the Acts
passed by the British Parliament. In 1938 Sri Jawaharlal Lal Nehru declared: “The Indian
National Congress stands for independence and a democratic state. It has proposed that
the constitution of free India must be framed, without outside interference, by a constituent
assembly elected on the basis of adult franchise. That is the democratic way and there is no
other way short of revolution, which can bring the needed result. An assembly so elected will
represent the people as a whole and will be far more interested in the economic and social
problems of the masses than in the petty communal issues which affect small groups . ”

The inaugural meeting of the Constituent Assembly of India was held on December
9,1946. It was presided over by Dr.Sachchidananda Sinha who was the oldest member of
the Assembly. On December 11, 1946, Dr. Rajendra Prasad was elected President of the
Constituent Assembly.

On December 13, 1946, Shri Jawahar Lal Nehru moved the “objectives resolution” which
later became the Preamble of the Constitution.

A number of committees submitted reports to the Constituent Assembly on the different
aspects of the constitution. On the basis of these reports the constitution was prepared by
Constitutional Adviser, Sri B. N. Rao. The Drafting Committee under the chairmanship of
Dr.Ambedkar worked on the draft and produced the Draft Constitution with 315 articles
and 8 schedules. The Draft Constitution was considered by the Constituent Assembly. In
its progress through the Constituent Assembly, the constitution grew in bulk and took its
final shape with 395 articles and 8 schedules. The time taken in accomplishing this task
was exactly two years, eleven months and 17 days from the first meeting of Constituent
Assembly on 9" December, 1946 till November 26, 1949 when “We, the people of India”
gave unto ourselves the new constitution.

There have been over 92 amendments to our Constitution so far.

Procedure of Amendment:

The Indian Constitution is a combination of rigidity and flexibility. It has neither the rigidity
of the American Constitution nor the flexibility of the British Constitution. Three different
methods of amendment have been provided under the Indian Constitution.
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First, certain provisions of the constitution can be amended by Parliament by ordinary

legislation. For example, Parliament may, by ordinary law (i.e., a law passed by a simple majority)
form a new State out of the existing States, increase or decrease the area of any state, alter

the name of any State, etc. Again, for abolition or creation of Legislative Councils in States,
Parliament may, by ordinary law, provide for this, provided the Legislative Assembly of the State
concerned passes a resolution to that effect by a majority of the total membership and at least

a two-thirds majority of the members present and voting before Parliament undertakes to pass

such a law.

)

176

Secondly, certain specified provisions can be amended by a special procedure.

In case of the aforesaid order having been made any of the following persons shall be
required to preserve and produce all the books, registers, other documents and records of
and relating to the company/intermediary/other person being in its custody or power: (i)
every manager, managing director, officer and other employee of the company ; (ii) every
intermediary referred to in Section 12; (iii) every person associated with the securities
market. The investigating Authority may also examine any of the aforesaid persons on
oath. Further, Investigating Authority may also examine any of the aforesaid persons on
oath.

Further, investigating Authority may call for information, books, registers or other
documents and records which it considers relevant and necessary for the purpose of its
investigation. It may keep the records produced before it in its custody upto 6 months. It
may issue certified copies of those documents for use of the person on whose behalf the
books and documents have been kept. In case any person referred to above refuses to or
fails to furnish the desired books/records/information or refuses or fails to appear or sign
the notes of any examination, he shall be punishable with imprisonment for a term which
may extend to one year, or with fine, which may extend to one crore rupees, or with both,
and also with a further fine which may extend to five lakh rupees for every day after the
first during which the failure or refusal continues.

Investigating Authority has also been empowered to secure an order for seizure of
books, registers, other documents and record by making an application to the Judicial
Magistrate. Such an application can be made where in the course of investigation, the
investigating Authority has reasonable ground to believe that the books, registers, other
documents and records of, or relating to, any intermediary or any person associated with
securities market in any manner, may be destroyed, mutilated, altered, falsified or secreted.

After considering the application and hearing the Investigating Authority, if necessary,
the Magistrate may, by order, authorize the Investigating Authority- (a) to enter, with
such assistance, as may be required, the place or places where such books, registers, other
documents and record are kept; (b) to search that place or those places in the manner
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specified in the order; and (c) to seize books, registers, other documents and record it
considers necessary for the purpose of the investigation.

However, in case of a company intended to get its securities listed on any recognized
stock exchange, order shall be passed only if such company indulges in insider trading or market
manipulation. Further, records seized must be returned back to the company/body corporate
after the conclusion of the investigation. Search and seizure, as aforesaid, shall be carried out in
accordance with the provisions of the Cr.P.C. 1973 relating to searches or seizures made under
the Code.
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w/ with (something)
w/o without
w/i within
ie. that is

® e.g. for example ®
etc et cetera, so forth
bc because
b4 before
re: regarding, about
esp especially
min minimum
max maximum
govt government
ASAP as soon as possible
wrt write
rt right
yr / yrs year, years
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C.
Vs

ch

Q A

ex

wd  wds

ref

diff

circa, about, around, from the year

versus, as opposed to

chapter

question answer

example
word words
reference

difference

SIS GSLD (1) Fl6UrhIGLD (Y6OT 2_6iTerT
euny SHemsulledr & (H&eLD:

® B pol - politics
B gov - government
B subj - subject
B info - information
B intro - introduction
2_uilearsens Lmaeuofl $g6:
B prbim - problem
B schl - school
B bkgd — background

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 179

(P19 6UEML LD 6UMT HemSHulled &i(H&&LD

SIM)FHev:

B govt - government
u gov't — government
B interl — international
|

. ' . .
inter | — international

ing emw Lm&600fl S36D:
B ckg - checking

B ckng - checking

| ck'g - checking
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efleorm:

(a)

(b)

(c)

(d)

(e)

180

GuaBLésamId HDhHs SPEHGETTL ieTeYSEBLET Frlgll QI LS SpeUTITHemS
©_(HEUMTSHSHEYLD.

Uss Slene — A4
U MhiGerfleorT ereooreotflbemnd — 4

Ged LSS 6D 1.25 SMIGEDLD HM LUSSMHISET 0.75 SihiE60LD

Slp&H&HET0TL. 2_emIemll 2_6iTerfIL 6.
HAPPINESS:

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is
a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—-long pursuit.

HAPPINESS eretTeiid semeoliling er(p58 euemauieor sieney 18 yeraflear, er(pssl
auema Arial, H1q1060T, eMLOW BemE6) P QI E)LL L OHEDETE OFIIS.

USHES SPSHSHEITL 6UIE)L L EOHEN6TE C1FILIS.

(a) Font - Arial
(b) Font size - 12

(c) Alignment — Justified

(d) Leading - 20

S} 6LETTT HMS 'happiness' eTeoTn GLwWifled GFLO&HS.
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gl emm:
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredtm
auflemsuied Heafles agFilg @ UHw CURCLEST SHaUTTIHMSS HDEHSA|D. LLSH6
srligujetereurm) HCLM CuLGL&EST seiteored Hlemn GHmedTmibd.
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2. ulgtulenLuiled File > New erettLemss Slafle asiweyn. (sieveog) Ctrl + N ereorenid
eflemsliLenemns GNIGS auflemnwill LWeTLI(bSSD. && Document Setup 2_emmwimLed

QULIgemWS SHMEBGSLID.

B Page Size SYlnig ulleuliquied Hefls aFiigs A4 eeTand USHS
CaihaghéHsaD.
® B Number of pages 2_emrlieLliquied 4 ereor & _aTearfleyw.

B gurhsefler Siememel &p&seToTL 6UMD) LOMHMEYLD.
Inside - 0.75 inches
Outside — 0.75 inches
Top - 1.25 inches
Bottom - 0.75 inches
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3. OK eunsgmemenr &efls asiwieyD. LULSH6d srliqujstareurm) Untitled — 1 eTeorm ewwirfled
ysw speuevord flemguied CameoTmid.

4. 6L&6VL themend Hefle QFLE QI 2 DISSTGIHeOW 2 [Heurssayb. Ung &6
QBM(bSSBLILL(H6TeN _emIemll SHL L& GIFIILLIEYLD.
HAPPINESS:
Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is

a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—long pursuit.
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5. GIL&HEL chemeDSH Q\BHTE00T(h 'HAPPINESS' eTeTUEmS S BHIHOSH & &LD. Character Control
Palette cpeold 61058 6uems Arial, 158 euemsuletr siemey 18 Leerflser, Leading 22
eTeoT LOMHMEYLD. Bold eungsnementd Heafled aFwweyo. U@ emww Qemgadng Shift +
Ctrl + C eretreniid smel G&IonerH6ms SH(QSSHELD.
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6. 6IL&6L (hemeDSH 6&HMettI(h LHFHemwd GHImHesHbeHseyw. Character Control Palette
cpeold 6T(RSHG euemd Arial, er(pss euemsulet siemey 12 yeTeflser, Leading 20 ereor
wrppeyw. Ung Criss emsalng Shift + Ctrl + J erettenid snell GaIONEIHems

Si(RSBEYLD.

QFlLIemM 185

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 185 @ 1/14/2020 4:41:00 PM ‘ ‘



| T T ® . T ||

7. SH6UCTUIHNS 'happiness' eTeoTn GlLwifled GaL&Hs

eflemsLiLeemaulied Ctrl + S eTedTLemS Si(RSHSEUD Sevevd UL lqliL emLuied File > Save
eTeOTLIEMSS Herflé aFlwieyb. Save publication 2_emguwimed ey Gsmeormid. File name
2 _emrlieILLiquied 'happiness' 6T60T HLL &S 615G Save aunsSmenesd Hlafls QFieD.

eeuerfluicy:

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and

full of challenges. Happiness requires life-long pursuit.

w6y
THIUMTTSSLILULL (P196) HeDL S5SHEI.
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CuyCGuasasr — ainfledliL O 4
LIOEm&HEMII (I 6UIMTE EHFH6D

eleorm:
GugBdsenIll LweTUbSH SpésetorL wreooreul SAMeNlLL LEDMSHEMW 2 (HEUTEHS.

Student Notice Board

BCugBussemrll LweTUbSE wnevoreul SMledlilyll LeDemHemU 2_(HEUTHEH6D.

&L emM:

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0
areorm euflemsuied Hlefls &S B LS CURCLEST HeUETITSHMSS SMESHELD.

2. ulliulenLuied File > New erettuenss SHeafle agweyb. (siedeog) Ctrl + N ereoremid
eflemsliLenems GSMIGHS eUdlemILl LWeTLbSSeD. & Document Setup 2_emrwimLed
QuULIgemwd HmHGSLD.

3. OK eunggnemen &Hlafle egiwen. @ueung Untitted — 1 eteorm euwirfled L&Hlu
Sp6u6toTD FHlewruied GHmedTmiLd.

4. OISLMMEIGHED themeDLl LweTUbSEH 100 mm X 100 mm SiemeysTel 6ILLIG 6l 6UEMITLL
Geuetor(hld. iFled fwimedr (Cyan) Bmdemg Hrliueyn. tint wHlemu 25 Faeigwons
rHoeyd. Sueunes ULl SpésesorLeurm GemedTmi.
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5. 8CsBunmeiTm 100 MM x 15 MM SiemeyeTem LMHEDTIH UL LGemUI euemTl Geuesor(hiD.
® aifev &Ly (black) Bmdemg MHirliueyo. @nal eullgenw dwmer (Cyan) Hmw ®
Briuiuce auliguier Goebu@GHuled emeudbseayb. SUaumgl ULl Sp&esesorLeumm)
GamedTmILD.
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6. 6IL&6L thewedd &(HLIL BIDL UL Iquier SL & I&HSHelmha 6uens @b euemr Heaflsh

6515 8158 Geueturpib. LeoTeuT Sigled " Student Notice Board" 6T60TM)| SLL&S QFIILI
BeueooT(hlD.
eT(pSSle0r BIWLD QUL Iquiledt EIM(PLD 60TMNS (SBLILNS) S(HHSLD. 2_mIeml SLL &5
FILg (sl e Ctrl + A ereitend ellensliLens GMNIHS ULl CLOEOLD 2_emTemil
GaIHOSbhESLD.
Character Control palette cpeoid er(psSletT Siememen 20 Ueaflsemms wrHmeyD. Bold
uettfls@nlemws Hefld aFlweyD. Reverse eunggnemensd Heafld sLFHTED 2 _6mI
G6uaTeman [HMLOMS LIMID. 2 emIenw enwul Bensey agiw Shift + Ctrl + C eredrend
aflemslLnems GSMNIGHS Ul LWETLGbLSSHRD. @reurn(ps wrssoreul SipleiL
LeDems SpdHeetorLeumm| Hlemruied GHmedrmiL.

eeuefluich:

wey:
THITUMTSSILULL (D196 HeDLSHSE.
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CuaCusal — eldLig M
SMTEML _(H6UTSHEHSHE0

eleorm:
GuaBwssemIll LWETUbSEH SpdsetorL efldliqnm SNTenL 2 (HeUTHE.

S. Barath Kumar

Vision TECH

5, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000

BGuhBsHsemIL LW6TUbSSH 1sMbeSULL(beTen LI nk SMTenL 2 _(HeUTHESSH6D.

gl emm:
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 ereotm
auflemsuied Heafles aFLgH @ UHw CURCLEST SpeUTTTHMSS SMHSED. UL SHHeD
srLiqujerereurm] SGLIL CuyCasT eoteored Hlewr GHmedTmILD.
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2. ulgtulenLuiled File > New erettLemss Slafle asiweyn. (sieveog) Ctrl + N ereorenid
eflemsliLenemsd GMNIGS auflemnwill LWeTL(bSSD. && Document Setup 2_emTwimLed
QuULIgemwS SHMEBGSLD.
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3. OK eunsgmemenr &efls asiweyD. LULSH6d srliqujstareurm) Untitled — 1 eteorm ewwirfled
yslw speuevord flemguied CamedTmid.

4. @ueunpg sersipbaener Inches edlpbg Milimetersé@ omHmeyLD.
uligluemLuied File > Preferences > general eredtm &L Lemememwd &lerflé G1FWWLIGYLD.
(s1eve0g)) eflemsliLeoensuied Cirl + K erettuems sipsseyn. @ueaunpg Preferences
2 _emIWIML6d QUL GaHmedTmiLb.
aifled Measurements wpmid Vertical ruler S¥iprig ulgleuliquised Milimeters
eTeTUEmS S BHITHOSH(bSH&SHEYLD.
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5. &l auULiquiled[BHhe OTSLMTRISE hewed CHIHOSH(bSHE OFUEUSLD 6UEDITUIOLD.
6. Control Palette &eb width 95 mm ereoteyd height 55 mm ereoTeyD LOMHMEYLD.
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7. &@meduauLiguiled 61L&6L. chemed Slerflé FIIWIeYD. HLL & & Geustoriqul & _emruileot
eTebemEemWS GMILTIL eFeueusSHedT BL g cpeneouled(phal 6UEDS CLPEHED EUEDIT
Hafles asigH S(1p5&H6D.

8. mulfleor OUWemT 2_6iTerfl(h, SiIemS GIL&H6IVL. ehed cpeold BHIHeGbaH&a. Control Palette
cpeold BHEMEUWITEDT 6T(IRSHG] 6U6ME LOMHMID ET(RSHSI60T SieTEWEUS O\BM(b&HSLD. Ll60TEOTIT
6uens| LUmwons Anfle mHeTSHeL.
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9. UgFlemed 7 & OMILIGUID QFLIWIEYD. [Him|euetTSHHle0r CLemT 266l (h, SiemS G SH6vL
thed cedld BaIHeSb&&HeD. Control Palette epeold GsHemeulLITEDT 6T(1058] 6U6MS LOHMILD
TIPS SieMTeMEUSH QBN (HSHSHEYD. LN60T60TT 6ue0& Lmons SANlE HHTSHSED. (PSH6D
ET(R5HEMS 6IL&H6L ¢hed epevld CHIHOSHHSHSI 6T(RSH8I euensHUTletT SieTemer QLIflEHT&HSeD.
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10. ugflemeo 7 & MWD QFLwWeD. Hineuersdler (waeufleww 2 stafl p, Siens
GIL&6IVL ehev epeld BaiThesbhe&a . Control Palette epeoid GsemeulLITEDT 61105 S 6U6MS
LOHMID 6T(IRSHH 0T SHETEMEUS Q1GHM(bHSED. Ll6TeoT euend Lmwns Amrlg HeTSSHeYLD.

eeuefluly:
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CugGuwssl — e Geollener O 6
(Label) 2_mmeuns@s6d

efleorm:
BughBwdHsenTll LwWeTLbSH EpdsetorL Geollemer (Label) o meunée.

BugiBudasemIll LWeTLbSSH asMbeeIUL (baer Gelener (Label) o _meaund@se.

&L emM:

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredtm
auflensuied &efls &LS @ LSW CURCLLEST HeUETTSHmSS SMEHSHELD.

2. ullulenLuied File > New ereotuemgs Herfls asiweyn. (sieveog) Ctrl + N ereoremid
eflemsliLenems GSNIGHS auflemwill LweTLbSSewD. && Document Setup 2_emmwimLed
QULIgemWSH SMSHSLD.

3. OK eungsnenen &Hefls eswen. @ueurgs Untitled — 1 ereorp euwirfled LHlw
Sp6uetord FHlewruied GHTesTmID.
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4. Yn@ enefipademen Inches edpb& Milimeters &@& onbHm Geuedor(bld.

ULl emLuied File > Preferences > general etedtm &L Lemememwid &lerflé G1FWWLIGYLD.
(1eve0g) eflemsliLeoensuled Ctrl + K erettuems sipsseyn. @ueunpg Preferences
2 _emIuImLed aLLly GHmedrmib.

aifled Measurements wmmib Vertical ruler &¥lnrkig uliglieiuliquied Millimeters ereTLems s
GCaibHesboHSaLD.
5. s@melOULIGUIedBHE OTSLMRISEE hewedd CHIHOSH(bSHEH C1FUEUSHD EUEMTUIEYLD.
6. Control Palette &eb width 100 mm ereoreyd height 40 mm ereoTEYD LOMMHMEYLD.
7. ulglulenLuieo Element > Rounded corners etettLuemss Slerfle Q&ILIGYLD.
8. Rounded corners 2 emgwnLed 6QULIquieliphas GCHemeuwimesr 6l eUHMSHS
GaHeagHbh&HSa|D. SUOLN(IQE QI L (PN 6F6lausHD GHTeTmID.
9. smellauluied eL&evL hemeds Hefled QsFLg, 6FNSHESHDGET &
9 _emISHOSTGI MW ©_(HeUTHSHELD.

10. Name : erelTUEDSS FHLL&F& Q5IG HIEDWE)| elemFeml SH(RSHHELD.
STD : eretTLEmSS FHLLEFS Q5ILIG HIEOWE)| elemFeml Si(RSHHELD.
Section : eretTLEMSS HL L 56 61FILIG HIEWLPE)| 6XlemFMIUI SH(RSHHELD.
School : eTetTUMSS HLL&& 615G HIEWLPE) ElenFenI Si(RSHSELD.
Subject : eTetTLEMSS HLLEE Q&L HIEWLPE) lleNFNII Si(RSHSHELD.
@ 11. 6IL&6L hemEDs E1&HME00T(H 2 6WIT (P(REUMSU|D CHIHOFH(bEHEELD. @

12. ulluiemLuied Type > Indents / Tabs eredtUems® Hlerflé QFLIWLIEYD. (Si16DEVSI)
eflemalileoemauiled Ctrl + | er6TLIENS SH(RSHSEULD.

13. eueng tab g8 90 mm sieredled ELMBSHSEYD. leader OLTSHHTemerTS Herfle AFIIS EUIHLD
uLiquwedled YeraflaGamiemL s Gaameshseayn. Weoters Apply eunssnenensd el
QFIWeYLD.
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14. @beuns Caemauwiner GeolleT 2 _[HauT&HSLILILIHSELD.

eeuefluicy:
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MYSQL: sreyssensdled 2_emer
&HL_Lemel&erfledT LILIeOTLIM(h

1. CREATE - ST6YSHSHEMD LOMHMID ASHETT ALTIHLHEMET 2 _(HeunsH&sed (table,
index, views, store procedure, function, and triggers)

2. ALTER - an&eTBeu SHHGD HT6YHHETHemS LOMMHMILIEHLO GG 6D.

3. DROP - FHTYSHSHETHH D 2_6Tan OUMIHeme H5ESH6D.

4. SELECT- SIEYSHSENHHED QD HHEUMHED H(IHLOL 6T(hSHSED.

5. INSERT - SIemel (H S Leueneooruied G&T5Hseb.

6. UPDATE - il Leuemetoruied ermaseoTGeu 2 emem HTemen GLODLI(HSEISH6D

7. DELETE- STEYSHET  SLLeUHeTTTUIed 2 6Tem SIWEVTHEISH 5856608 6METIULD
H&ESSH60.

My sql gl LwiestLhSS DDL wpmito DML elesorenemens 615u160m&&6d

Q&I emM:
1. (MYSQL command prompt emw Hmé&s) XAMPP control panel euflwins

2. BIEYSIHNSHHL 2 _MhGHEHemLII LWET 6w (user name) MHMID &L 6YFEIFTED60 DL
(password) LWedTLI(bSE] 2 _6THIEMLOSHED

3. e&npésiulL DDL MysQL eflermeusmeouilement 61&wedLIbSSH QeuefuiiemLL OLm)s.

SYNTAX:

Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;

* CREATE TABLE table_name (columnldatatype,column2datatype,column3datatype, ....);
* ALTER TABLE ‘table_name' ADD COLUMN ‘column_name" ‘data_type';

* DROP DATABASE databasename;

*SELECT * FROM TABLE NAME

*INSERT INTO table_name( fieldl, field2,...fieldN ) VALUES ( valuel, value2,...valueN );
* UPDATE table_name SET field1 = new-valuel, field2 = new-value2 [WHERE Clause]

* DROP TABLE table_name ;
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Bl ev:
CREATE DATABASE SchoolDB;

CREATE TABLE student(
studentID int,
LastName varchar(255),
FirstName varchar(255),
Address varchar(255),
City varchar(255)
);
ALTER TABLE ‘'members’ ADD COLUMN "credit_card_number' VARCHAR(25);
DROP DATABASE SchoolDB
SELECT * FROM student
® INSERT INTO student (studentID ,LastName , FirstName,Address,City ) VALUES ®
(“002”, “Ram”;’Kumar”, “ROJA NAGAR”YCHENNATI”);
SELECT * FROM student
UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;
SELECT * FROM student
DROP TABLE student ;

SELECT * FROM student

QFlLIemM 201
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aeuefluicy:

Database created

Table created:

StudentID
101

202

002
003
StudentID
101

202

002
003

Table dropped.

Table not found.

studentID LastName
Table Altered

Database dropped
StudentID LastName
101 C

202 S

One row inserted.

LastName
C
S

Ram

R
LastName
C

S

Ram

SRI

FirstName

FirstName
Priya

Ramu

FirstName
Priya

Ramu

Kumar
Krishna
FirstName
Priya

Ramu

Kumar

Krishna

Address

Address
1, new street

5, North garden
St

Address
1, new street

5, North garden
St

ROJA NAGAR
Park Street
Address

1, new street

5, North garden
St

ROJA NAGAR

Park Street

City

City
Trichy
Madurai

City
Trichy
Madurai

CHENNAI
Coimbatore
City

Trichy

Madurai

CHENNAI

Coimbatore
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PHP — suqliuemL. Hlired

sigliuewLPHP firemed o meunsdl aeuefluilemL Q1LmISHeD.

gl emm:
1. Xampp Server (Apache) gl6umni&ged.
2. Goto &l GamiyemnmsE egeased (Virtual path folder) (c:\xampp\ntdoc)
3. test.php file Gamiilemeor 2_(Heunsd), HTemed FLLFF OFUIS.

4. (http://local host/test.php) eteédTm UL L 6med LWEOTU(BSE 2 _rhiseT euemed 2 _someflulled (web
browser)blTeme0 @uissHaLD.

lmeb:

) <html> ®
<body>

<?php

echo “Welcome to Our School”;
$color = “blue”;

echo “My car is “ . $color . «<br>";
echo “My dress is “ . $COLOR . «<br>";
echo “My box is “ . $coLOR . «<br>";

/I test whether a number is greater than 30, 20 or 10 using ternary operator
functiontrinary_Test($n){

$r=$n > 30

? “greater than 30”

:($n > 20

? “greater than 20”

:($n >10

? “greater than 10”

QFlLIemM 203
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: “Input a number atleast greater than 10!”));
echo $n” : “$r’\n”;

}

trinary_Test(32);

trinary_Test(21);

trinary_Test(12);

trinary_Test(4);

7>

</body>

</html>

Qeuefluly:

Welcome to Our School

My car is blue
My dress is
My box is

32 : greater than 30
21 : greater than 20
12 : greater than 10

4 : Input a number atleast greater than 10!
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10.

11.

12.

13.

14.

Business and Commercial Knowledge,
Foundation course by Board of Studies,
The Institute of Chartered Accountants
of India (ICAI)

Business Management Ethics and
Communication, Study Material, Paper—
Il, Foundation Programme, ICSI.

Principles  of
JJAYASANKAR.

Principles of Management by
KATHIRESEN AND Dr. RADHA

Principles of Management by
P.C.TRIPATHI AND P.N.REDDY

Management by

. Principles of Management by L.M.

PRASAD

Business management by Dinkar
Pagarew

Principles  of
J.Jayasankar

management by

Principles of Management by kathiresen
and Dr.Radha

Principles of Management by
P.C.Tripathi and P.N.Reddy.

Principles  of
L.M.Prasad

Principles of Management by Harold
Koontz , Heinz Weihrich and A.
Ramachandra Aryasri.

Management by

Principle of Management — P.N. Gupta
(2005), S. Chand & company Ltd,
New Delhi (First Edition)

Principles of Management, Eighth
Edition — Theory & Franklin (1999)
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14.

15.

16.

17.

18.

19.

20.

21.

22.

A.LT.B.S Publishers and Distributors,
New Delhi ()

Principles and Practice of Management
— T.N. Chhabra (1997) Dhanpat Rai
and Co (pvt.Ltd.), New Delhi.

Principles of Management, Tenth Edition
— Harold Koontz, Heinz Weihrich and
A Ramachandra Aryasri (2004), Tata
McGraw - Hill Publishing Company
Limited, New Delhi

Organizational Behaviour — L.M.Prasad
(1993) Sultan Chand & Sons, New
Delhi

Organizational behavior - Stephen
P. Robbins and Timothy A. Judge (
2013) Prentice Hall, USA

Business Management, Fifth Edition -
Dinkar Pagare (1993) Sultan Chand &
Sons, New Delhi

Principles and Practice of Management,
Sixth Edition - LM Prasad (2005)
Sultan Chand & Sons, New Delhi

Stephen P Robbins, "Fundamentals of
Management: Essential Concepts and
Applications", 5th Edition, Pearson
Education., 2005

R.  Sivarethinamohan and P.
Aranganathan, "Principles of
Management", 1st Edition, CBA/Tata
McGraw —Hill Publishing Company Ltd.,
2005.

JamesA F Stoner ,Edward Freeman
and Gilbert, "Management", 6th Edition,
Pearson Education, 1995./ Prentice
Hall of India Pvt. Ltd., 2007.

SN HTOS6T 205

1/14/2020 4:41:02 PM ‘ ‘



23. Durbin, 'Essentials of Management" 32. www.google.com.
7th Edition, Cengage Learning India 33. Principle of Management — P.N. Gupta
Pvt. Ltd (2005), S. Chand & company Ltd.,

24. Albrecht, K. 1980. Brain Power: New Delhi (First Edition)

Learning to Improve Your Thinking 34. Principles of Management, Eighth
Skills. New York: Simon and Schuster. Editon — Theory & Franklin (1999)

25. Bourgeois, L.J. lll, and Kathleen M. A.LT.B.S Publishers and Distributors,
Eisenhardt. 1987. Strategic decision New Delhi ()
processes in silicon valley: the 35. Principles and Practice of Management
anatomy of the living dead. California ~ TN. Chhabra (1997) Dhanpat Rai
Management Review (Fall): 143-145. and Co (pvtLtd.), New Delhi.

26. Dess, Gregory G. 1987. Consensus on 36. Principles of Management, Tenth Edition
strategy formulation and organizational — Harold Koontz, Heinz Weihrich and
performance: c.ompetitors in a A Ramachandra Aryasri (2004), Tata
fragmented industry. Strateglc McGraw - Hill Publishing Company
Management Journal 8: 259-277. Limited, New Delhi

27. Drucker, P.E. 1974. Management: 37. Organizational Behaviour — L.M.Prasad
Tasks, Responsibilities, Practices. (1993) Sultan Chand & Sons, New
New York: Harper and Row : 466- Delhi
467.

38. Organizational behavior - Stephen

28. Eisenhardt, Kathleen M., and Mark J. P. Robbins and Timothy A. Judge (
Zbarecki. 1992. Strategic decision 2013) Prentice Hall, USA

king. Strategic Management
Toel‘Jrlr?:I 13 20 922 9 39. Business Management, Fifth Edition —
’ ' Dinkar Pagare (1993) Sultan Chand &

29. Decision Analysis for Managers Sons, New Delhi
Th titati A h t
( e. . Quan |.a Ve pproac ©s _O 40. Principles and Practice of Management,
Decision-Making Collection) by David . .

Charlesworth Business Expert Press Sixth Edition — LM Prasad (2008)
P Sultan Chand & Sons, New Delhi
(March 25, 2013)

30. Business Communication — Radha
Kadhiresan, Prasanna Publication.

31. Business Communication -

B.Santhanam & Raghunandhan,
Margam Publication.
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1. https://prezi.com/ukyOpOepe5nv/controlling—in-mangment-case-study/

2. https://www.researchgate.net/publication/264971297_A _Case_Study_on_Inventory__
Management_Using_Selective _Control_Techniques

Company Law and Secretarial Practice by Srinivasan.

Company Law and Secretarial Practice by Radha Kathiresan.

http://www.business communication articles.com/types—of-secretary-with-its—definition/
https://en.wikipedia.org/wiki/personal assistant

http://www.inc.com/david.../the—4—-kinds—of—personal-assistants—which

® NN sw

https://study.com/personal assistant.html
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HEMEOF C\F MM H6IT

GmrGomen

HBI&HSH QUMTHemH AT HHLD " Gloeomesoremio

ugeueons il gieTem

&eTemm UDHMl LIG&ESD GuTg (S1) LWETLGLSSID Cug

SITT600TLD SMIe0oTHBHM(b FnMULLL6m6U (1) HMTevor eXlendd SerfleHaULL L
Ganlunser
LT 6U60MSH GLoeoTetoTEmID ETEDTLISI LITEUEDITE0T 6Q60TMISHT60T

(60T euT [flemed SHimedr

6(H 2_evoTemio [Hlemed (1) gylprhlemed (WedT et [HlemeoGuimch

SDHOFWd & Ceauemer, U (S1) THTUMNTMOED GDLIL &8 1qUIH|

B emerGWimy &6l eDedDLILEDL, Hligarerm

eTlIaum(Q &I 1H600TL., GIHIHMHIGTEOLONE

8 DDELS6IT Fngemeotenwiumn), Guiraummeud &Her

CrrésIhiser HMILOrhISHET 66UEEUTETMID 2 _630T(h

C\BITET 60 & & 6iT GaML_umbL 60T 6\&MetoTL. Q60dHE

HEDL(Lp DM S 6T B euns SseoTemiouded, SlepeuesSSHed Heml LNg&Hs Geuevoriqul
Qe

el Flser HemLLg5Hs Geuevoriq 66T

Pl&p&d Hlimed adlianensddled HLES GuUTelend &HevolléHd

uLegL aumeunll, aseelerhisener LFHle] OFLEUSHES 6 GSOILILL
HMOHHDES
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2 _Sdl&er Q@ STwnelésiulL Sesbens ML LILETLI(HEUS.

&IT5H6m 60T SPIIIL 5558 cuensHuied aCHETID CIFILIFHED SiDE0E HHEWL 6D

S HMILD (W O6UbLEHGSD FHMET E\HM60oTL. HLIT

&M QFLIWIILGBL UGS

©_6U0TIT 6L 60T Hlemed Si6bevg eNYILIL|6ToTTTEY SITLD

1}, &6D W196) 6T(bHSH SUIedNs Lo6DTHI6m6d

Beuetr(h6I6oTEM ellifllievorie|Leor HMID Ceuetor(helnedTED 660TEmM E1FILISED

eXlen&sLb QU] GNISHS 6X6M5ESH6D 160608 Q60TN GMISHE| )| 6TEOT60T Si6DEDS)
aig| o8 Gumettm ConeTmIADE eT6dTm) 66T ESH6D

2 _migl & Uetoflemw asiwDbEUNS QHENT ST (LD ST

S(1PSHSLD KM FLRISHS SiFHewns g HApluns SriuLGeuevoriqul
(P&HHSH G|

BlTeundl ewmurSled (P16 HEm6T Th&SD WHS Hlemed DemiPluiy

15146007 & &l 6ULD LuInd, Ly Siebeog HemL(Ppemmuled STHHeLILbLD Sirley

QFWELML(h ieWmOLL —  EFWEUML(H SiemLIL] 6TedTLS 6Umg)
euemsWTeT  Fimieuerr Siemwlun@. @&led [FHmeueotd iy
QFweLN (b UGH&ernerr 2 pusH Bl Siebevd &hHemSLILI(bS&ISH6D
Sdlwenr sigliuenLuied fAm Gp&sens iflssiul (heterg).

euflems SiemLoLi

Guendlanifl Heo1dH@ S(eTer sMiBlened 2erflLifsHEnsE S ST HEnS
udipsellsHnnT. <ig  Hneuer Siemwlifed euflems eugeiled
Guedlmha Speuenr OSTLIHDE

aufleds LOMID 2emBluiy

SlemLoLIL

auflens QsweoLnnh 2 S5TelbHns WLOHMID erfluil EFWIEOLIT(H
doly pGeonsemeot wWLHMID 2 el eupid HmeuerHHHE
glemevofh&Hmg. siflenfleser Hnen &esE wHMID Henssemner
oarfluifser HlemmGeunmiSmmT &ei.

GmHenBbH&IsHed

QW euneefler uGd wHODTE euTmsT HpeaIOISHeTer HCSH
—UGHem SEHTLOSHS60

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 209

BHEMEDF C\FTMSHET 209

@ 1/14/2020 4:41:02 PM ‘ ‘



® CH ||

fimieueoT SiemioLiL

Bimieuenr SLLemWLL eredTug FmieuenTsHHled HHEUDSHET  6(H
Hlemeouled®h g LHODIH HleneddHE ereueumm LMLSDE 6TeTLensS
Sioneollliug. o1& HoeuensHer eeuaeun LUeooll  Sigeor
QFWIEOLIM(b&ET WHMID 6ThIG SiM&Hens Siaflss Geuetonbd ereiTLg)
Gurestmeupemm &HevoTLMADE. Seueusmioli SemOLL 6EUEDTLLLD
ceold elen&sLLbEDE.

SIeWLOLIL 6UEMITLILLD

QW HneuarsHler 2 61 SLLemwlenu 2 [BHHECHMIL®b &ML
ULLD Siedll 6UenTULLD 6TeorlLi(blD. Siemiolil] euedTULLD 6
FINI6UEDTLD 6TENEUTM)| SLL 6MIDSSLILIL(bETETS 6TE0TLIENS 6ILITSHIEUTS
sSMLAUUGSHFDE. SeofllbUBHSHS HneueaTsHHed 2 eTem LMKG,
eumTmILY WHMID ASTLIL&HeDeT 2 (HSE&HMIL(H ST (bHMGI.

(peoT@eoTmig. (WetTeoTT QFWHINS (PSHEOT(LEMMUITS OFWILD LI6vof]
aUSHH &SET LTeueons eNeunfls@&D 2 _600TemlD Sib60E 2 600T6MLOWIEDEDTS
&HH6UDSHEIT
ewmmCi L6oofl QSMLITUTS Q&FLILIGEU6TUTIG U &HL 6mLDSHEIT
H60T60 | FemFIWIMTES ereuelad swmfliydeorm) Hlieameor
®
QFwFLe &levoriq Ly

sieTeneus Gl STeoollaeT iemeliy OFLWLS Fnlquienel (6T.5M) Gn6dl euUPhISWIS).

LI600TL &M ThS SHMIT600f&H6T

2 _eoory WO (HBLD FnlqUl HMTE00f&H6M HMHLIWIT

SHTMLES

2_evoremioulement sirledlwied (pemmued Spuie) EFILISHED.

FHLL(pemm STLOMe0TRIE6T

SNIEW &med HMID HevorLamed S L rkisefleir &Heoeme.

SLLemWSSLILIL L
SITLOM60T MRl &H6iT

STLIOLIMIQ&ID Si6b60F SlHOUSHHIOL HHIQD HlEHLD6)seT

QBMTETEMEHS SITLOMT60TMHRIGH6IT

Guebrflemep GLoeomeToTemLOWITED 6T(h&SLILILED .

SLGbUUGBSSID STevoflser

SIIOMEOTD QFILGHEMED FH(hHGSLID SHITT600f|SHeT

sinfleysSmeot &nihs
6T 600T600TLD

LDETSEDNET LSSHIITED erbLIbLD FlbSem 6ot
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69([H Ml & 606001 S56D aung Qesdenerr  SiemLeudHHTH ULLGeum — HewmEerled
CrM&sm&HemeT 2 _s5hHEH HSHSHDG.

5HIEMLIPLIL| Q5SIEWIPLIL eTedTLS @@ L& 2 miiflereny siBlpsliudgsgin Gung)
Guettfl&ns&LLGbEDS).
LITeoLITLD ugeourd eredtug SiemoLlifled uevoflyflud uesoflwimermiy serflemL Gul

2 et QDM GHSHHMDE

Gundl g Hed &5 SieWLOLI| HTeoT SewL Ll Ceuctor@uwl Be0éH& LHMID GSH&EHTemen
SemLeUSNHS dlafleHsLLpd Luind &b

BuwsGH SlpueooflnenT &@héH@ eULPTRIBLILI(LD S4em60oT LMHM)| N6 emIT&HemeTs
&DSADE

6E0TH6METTTHS 6UEDI6mLD & uetoflullement QFIEUSNE, & eTeoteor Levofl erGs Qslaug),
erliGung e&eug Wi &’ GUrHDNTSHET eTeTLSHENE0T & MI6EUS).

siflanm QLLeDLeY Guedihlemed ULetOlWMETTH6T FalBHEHHEG NBM(bHSBLLLL S SMILD
wLHMID  eurmliysener Shiser &  ueolyflueui&seEnsE
LMHBISSBEUSTSLD.
®
Gumunrenel Gupunienel ereiTUEH SHewedaul LOHMID GETM VDE SBSNHGS

GumulL mpuflLb 2 6Ter HemWLLMEGL. 5601 cpedld Lievofluiemeot
HeVED (emDUied AFLG (W &HS SWIEDE.

Delegation(Geuemen HSNTHWS HOTES ELp HOT HLLWOLILILG. 61 Geuemed
urkiserfiliy (1) Geuemed e&bLlg uesoflwmenflLb eULEDLILEGS SpGLD. SeUBD ibHS
u&liey) SiflaMTHens emm| Lesoflemw (01955 QULIEDLLILS SHELD.
Devolution Guedol L sie0@Hefled Bha SPLLL ADGSHEHHES AHSMTHmS
(aflsmoindiey) wrHBlweflinGs eredtm) s»meornid.

Deconcentration & dleo Leoflgemen WHH W (1) Bl SiTs&serfler (pseurflid,

QUUEDL S8 fmhs (wemwpuled (pusslieuneus. @5 Gume
Uevofl&em Beuemed LiEHemel &emmLILSMGLD, HeDed [Hf eums
Qeueflium igH@&L @eueurm| OFILWILILIGEDSI.

Decentralization @hg QFWeOLIMLIGET DD FIMID HL6UIGHEDSHSBEMEN (PSHEILILOTES
(UTEUENHGSHD () FHLLLObSED, (Plg616ubsHsed, Gurmetm Letoflsemer LiflH&15
DLOWILILI(bSSHTEmLD) Q&MGbLILG ve0g (WHAW aiFanr uGHuled Qmha Sphleneoued

o eteneuiseflLid SierfliiLg.
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egsLIflien

0560 E\FTELE0IED E\FIGDTEITT

NN

uempw Crmonesflwss Cuomdled agweonenfler GeuemeosHemen QFLILID

aidls

SIYI6UEDS CIFUIEOITEIT

SiIeUEs BeUemensH6lT, HLL &8, ei5TeneoGudluled LiFleveflliLig) LoHMID
Snl L Q(RMIG 618G GuTetn Geuemed QS HLIT

6ficp LHMID Fepd
euITMILIL|&6iT

seoflwmy esweomeny ey auUMMILIL&emer euslliLieuT

Bl& &LemL&HET

LI6DOTLD, 6UMhid] &60015E, UMIBHSIIL IO b, eurfl 2erdluib
GuEdTHEUHEMM EMSBIITETEUS] (LSHEOTETBET (LHEO(hHET, EU(BLOMEDT eurfl
goftiug), SISk OSTETHEHSHSHTET LIGOOID 61F6)IHEISH60

Seofl ©_gelwimerny

(waeomerfl QFeLAID CEUemeD&:6T LMHMID EUPSHESHLONEDT EeUEmEDsHEmaT
QFLILeT.

LT HHHLOMM SIeMLOLIL]

6U6DOf 1D 166N [FIMI6UEDTLD EOMLILOMMM HIMIEU6DTLD, SieEDE| EOMLILOMHM
SiemLoLIL

&L (bD6YF &ThlHLD

QLINHEMTSITI, FCP& LOHM) HeonsNT CHemeUSHEMeN &hSHléHs SIS
Ganihs HeoreoTnL & &rhl&Hld

HTHTHSDS TSI AU D0 GlqulhLiy iH sl
QSMPIDETRISLD eflwmuny ShisSSHET 6(QMISEDDSHSLILL. CUTHHS Fnl L LD
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Xl - esmflhseel — sigiauens Geomesorenowjld aFweSIwIID
WHMID SLLEF&D SHevoflefl LIuIedTLIM(HESEBLD

mreondflwiiser wHmID GLoeomlieuTeTT &6

el 9HGeOMFsT & EULAIBIT
wepareui GILITEOT. GLOMT

Bevevor @WS@GeoTT (UMLSSILLID )
onflend seveflufied Symiii&dl wHmid LuIH& Hmieueord ,
Qlg6iTemenT — 600 006

LIML[BITEd 6UEDEVIBIT SH6iT

weearai &. aQMedlef] Tmevof]
2_sel GuondflwiT wHmID Hewn Semeveurt
B eFweorflied gemn

Bunewsfl Guoifl sebeurifl (Gedreormidl)
6l&6TEmEDT — 600004,

LML 6([h a1 &5 6m 600TLILIMEITIT &6iT
(wemeuTeuT 1. Qenrhl@ameveoT,

(omBleo mebeom AT elH&I-2018)

2_geil Guundflwiy

omfle sevefluiied SyrmitEd) wHmib LuihH& HimieueTd
€15 60T6m 60T

LlIT.LDQ')ﬂ.'G)ﬂ@, ul gl @y Aflu,
wrfled sevelufuied pomitéd wHmid LuihHd Himieerd

6\F60Tem 60T

66w 6ToTLIL|
T@welq (wevflamsl
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UL med Al sei
woara.d.CreniaEnCeHead
2 g6l Guondflwim
seveflufluled gemmn
SIEOTEMET QBTSN 6T LIEDSEWEDS BHLPSLD

BT SSHTETED.

U. &5 WIBITTITILIEO0T60T,
glemevor GumAfwit
euettilseflled glewn
81.Cam.emeuetureus seoefl.

IBOUTSSLD, O1&6iTeneT — 600106.

615 emedTdmmenof]
glemevor GurmAfluiy

Bmuo asweorflied glewm
HBSSmSed HILMT SHeoeufl.
61&606UMILIED, E1&60TEmET — 51.

5.616urnkISBL&60T

glemevor GuomAfwiy

euettilseiluled glewmn

1q.6T610. HITMLETOTFMS] Semed HMID Siflelied sedgurifl

BTEUITHT, EF6dTemeT — 600 130.

USs& 6Ulq6U6emLOLIL]|
2 BrméELID G1LIENS6
61&60T6060T.

SLLEST
P. &MOML & emaTIe\LHLOM6T
2B&MS B, OF6TEneT — 600083,

6g.seme0Fe1Fevedl
Srmuymid, 6&eiTenenT — 600013,

QR Team

B, OR&HTHE0T, QoL Hlewed A,
sanrmi &) vl HbHlemeoliueerl,
&@evorgLyTLD, BUITEETBIT , & (H6LETUT6UTTTLO 6D ED.

w.@@@m&a‘n, u L gmfl oy Aflwid,
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